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E. Excel Mini-Exercises from our Text Book 
 
 
Purpose: Continue to expand your Excel skills, introduce a small Scenario, and a small Pivot Table.  
 
 
 
 
 

Mini-Exercise Components: 
 
 

1. Downloading your Starting Spreadsheet Template ........................................................ E-2 
 

 
2. Sales Projections ............................................................................................................ E-3 
 
 
3. Park Revenues, Introduction to Scenarios...................................................................... E-4 

 
 

4. Sales Data, Introduction to Pivot Tables ....................................................................... E-10 
 

 

Appendix: 
 
Appendix 1 – Uploading your file to Entropy ....................................................................... E-17 
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E.1 – Downloading your Starting Spreadsheet Template 
 

To start this tutorial, you will download a starting Excel template which will be populated with heading 
titles, row titles and starting data. There are three mini exercises that comprise this project to help you  
learn and practice typical Excel tasks.  

 

• All Excel projects are graded with the help of a computer system (Entropy), which means that you 
must follow directions closely and place all formulas, headings etc. in the exact cells specified or the 
grading system will not find your work. In particular, do not insert extra rows or columns as well as do 
not change the Sheet name unless instructed to change the title of the sheet. 
 

• Do you own work, and do not share any files with other students. 
 
 

a. Download a starting template from Entropy as shown in Figure E-1. Go to 
https://csbapp.uncw.edu/entropy (or Google UNCW Entropy) 

b. Find the Upload files/download link in Entropy  
c. Download the Template for the Mini Exercises: 
d.  

 
 

 
 
Figure E-1: Entropy screen for Excel upload/download files 

 
 

e. Save the downloaded file to the Download, then copy to either your Documents Folder or 
OneDrive. Do not open the spreadsheet in a browser. 
 

f. Rename the file yourLastNameMultiple.xlsx as in appleMultiple.xlsx 
 

g. Do not share this file with anyone else; it has been created just for you. 
 
 
Once you download the starting template, you will notice three sheets (tabs) to complete.  Complete all 
three tasks as described on the following pages and upload the completed worksheet to Entropy. These 
three tasks are: 
 

a. Sales Projections – using Excel for projections of Revenues 
b. Park Revenue – introduction to Scenarios  
c. Sales Data – gain knowledge of Pivot Tables 

  

https://csbapp.uncw.edu/entropy
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E.2 – Sales Projections 
 

1. Calculate the percentage change from year to year (2021 to 2022 and 2022 to 2023). Percentage 
change is computed using the following formula: (current year sales – prior year sales) / (prior 
year sales).  To help you get started, you should get the values as shown in Figure E-2 (before 
we format the cells to make them easier for a user to read). 

 

 
 

Figure E-2: Percentage gain/loss for our customers, before formatting. 
 

2. Calculate the total sales for each customer for 2021, 2022, and 2023.  
 

 
 

Figure E-3: Summary including Total Sales (before formatting). 
 

3. In Row 20, calculate the total for each year (not the % change). In the two % Change Columns 
calculate the % change based on the Total for each year. 

 
4. In Row 21, calculate the mean (average) for the columns which detail the sales (4 columns) 

 
5. In Row 22, calculate the standard deviation for the sales columns. Hint start with the = (equals) 

sign and then hit the fx  function tool, then look for STDEV in the menu 

provided. 
 

6. Your results should look like E-4. 
 

 
 

Figure E-4: Summary Statistics 
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7. Format the spreadsheet as follows 

a. The sales columns should be formatted with zero decimals, but include a , (comma) 
separator. (Hint: Right click on selected cells and then select Format). 

b. Format the % columns as a %, with 1 decimal place. 
c. Your completed sheet should look like Figure E-5. 

 

 
 

Figure E-5: Completed Sales Analysis Tab 
 
 
 

E.3. – Park Revenues – Introduction to Scenarios (2nd Tab) 
 

Note: More detail on this case may be found in the textbook appendices, starting on Page A-90, some 
numbers/headings have been changed for readability.  
 
As you know, one useful function of spreadsheet software is the ability to change input values and see 
the impact on outcome variables. For example, you can change sales projections and see the impact on 
net income. Excel’s Scenario Manager makes performing these sorts of sensitivity analyses much 
easier. Figure E-6 shows a simple spreadsheet that computes total revenues for a recreation park.  The 
sources of revenues are admissions fees, merchandise, and food sales. 

 

 
 
Figure E-6: Park Revenue Spreadsheet 
 

Assumptions for total visitors, admission price, and average merchandise and food purchases per 
customer are also shown, as is the number of days the park is open. The formulas in this spreadsheet are 
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simple. For example, total admissions revenue is the product of attendance, days per season, and 
admission fee. Merchandise and food sales are computed similarly, substituting the appropriate value for 
admission fee 
 
Park management is thinking about raising the admission fee, but they want to see the impact on overall 
revenue. They estimate that raising the admission fee to $50 will lower attendance by 50 guests per day. 
Raising the admission fee to $53 will lower attendance by 75 visitors per day.  
 
We want to create three scenarios: one using the current value for Admission ($45), one with a $50 
admission fee, and one with a $53 admission fee. 
 
 

8. Start the Scenario Manager. To do so, click the Data menu ribbon. Click the What-If Analysis icon 
in the Data Tools section of the Data menu ribbon. In the drop down that is displayed, select 
Scenario Manager (Figure E-7).  If you do not see the What if, you might be working in the ‘cloud’ 
version of Excel and not the version on your desktop.   
 

 
 

Figure E-7: Scenario Manager is found under the What-If Analysis icon in the Data Tools 
section of the Data menu ribbon 
 
9. The starting setup screen for the Scenario Manager is shown in Figure E-8. There are no 

scenarios set up when you first start the Scenario Manager. 
 

 
 
Figure E-8: Starting setup for Scenario Manager (Mac Users should click the + (Plus sign to 
add a Scenario) 
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10. Your first step in the scenario manager will be to add a scenario. Each scenario represents a 

different “set of inputs” from our spreadsheet (and management’s desires). For this tutorial, we 
will be creating one scenario for each of the three admission fee cases we desire to investigate.. 

 
Click the Add button to create your first scenario. Figure E-9 shows the setup screen that will start the 
creation of a scenario. 

 
 

Figure E-9 Setup screen of one scenario 
 
 

11. Each scenario must be given a name. It’s best to use a descriptive name because this will be 
displayed on the output report. In addition, it will be easier to tell the scenarios apart when making 
updates if you use a descriptive name. 

 
Name this first scenario No Change and place this in the Scenario name box provided in the scenario 
setup. 
 

12. Changing cells refers to one or several input cells that will be modified for each scenario. For this 
tutorial, we have two input cells that we will change, both F3 and F5 (daily attendance and 
admission fee), as shown in Figure E-10 

 

 
 

Figure E-10 Building the Current Case (no change to fees) 
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You may manually type the cell references into the Changing cells box provided. Alternatively, you 
can use your mouse to click the cells (holding down the crtl key) on the worksheet in the background. 
Feel free to move the Add Scenario window so you can see the cells below it.  Confirm your scenario 
setup by clicking OK. In the next screen you will enter values for each of the changing cells. For your 
first scenario (No Change), the values may already be inserted into the Scenario Value Panel as 
shown in E-11.  If they do not appear, type 1000 and 45 respectively into F3 and F5, then click OK. 

 

 
 

Figure E-11 – Entering the base case values 
 
 

13. We need to add two additional cases to show the impact of the change in admission fee. Name 
the 2nd scenario: $5 Increase, with the values for F3 to be 950 (reduction of 50 guests) and F5 to 
be 50.  
 

14. Likewise create a third scenario, name it $8 increase, with the values of 925 for F3 and F5 to be 
53. 

 
15. When complete you should have 3 scenarios built for analysis, and to help us determine the 

impact of potential price increases. If you made any errors you can hit the EDIT button and adjust 
your values. 

 

 
 

Figure E-12 – Scenario Manager with 3 cases 
 

16. We want to summarize our scenarios, which will show all three on a single worksheet, so we click 
on Summary. 
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17. When you click on Summary, a dialog box lets you choose the output cells you want to show in 
your summaries. In our example, we click in the Result Cell area and choose cells B4,B7, which 
contain the Admission and Total Revenue values; the dialog box with our selections is shown in 
Figure E-13. Click on OK to create the scenario summaries. 
 

 
 

Figure E-13 – Scenario Summary showing the result cells 
 

18. Once you hit OK, Excel will generate a new sheet (tab) with the 3 different cases and their impact 
on total revenues as shown in Figure E-14. 

 

 
 

Figure E-14 – Scenario Summary with 3 cases and impact on revenues before formatting 
 
 

19. You may notice that the Current Values are the same as the No Change scenario. This occurred 
because one of our scenarios happened to have the same values as those that are currently in 
the worksheet. This won’t always be the case. To eliminate the duplicate values, highlight Column 
D and click Delete to delete the entire column. 
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20. We can improve the summary by changing the formats of the numbers for the changing cells. We 
should also have more meaningful labels than $F$3. $F$5 etc.. We will use the ParkRevenue 
sheet to help with more readable titles. 

a. Click on B6, enter an = sign, and then click the ParkRevenue tab, and select E3 (where 
the title Attendance appears). Then hit Enter. You should now see Attendance appearing 
in cell B6 on the Scenario Summary sheet. Click on C6 and hit delete to clear out the 
prior entry. 

b. Do the same for B7, B9 and B10. 
c. Format the cells to be zero decimals, but with a ,  
d. Format the Admission fee, Admission, and Total Revenue rows to be currency with zero 

decimals. 
e. When complete your Scenario Summary tab (check that it’s name is Scenario 

Summary) should look like Figure E-15. 
 
 

 
 

Figure E-15 – Scenario Summary with 3 cases and impact on revenues after formatting 
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E.4. – Sales Data – Introduction to Pivot Tables (SalesData Tab) 
 

Note: More detail on this case may be found in the textbook appendices, starting on Page A-81, some 
numbers/headings have been changed for readability.  

 
The PivotTable is among the most useful tools available in modern spreadsheet software. PivotTables 
allow you to quickly summarize large quantities of data. In addition, you can quickly and easily examine 
the data by various dimensions. For example, the district manager of a retail store chain may want to 
examine sales revenue by store or product category. This is easy to do with PivotTables. You can go 
even further and examine sales revenue for each product category and store combination. PivotTables 
seem complex and mysterious to many spreadsheet users. In reality, they are quite easy to create, as 
long as you understand a few basics, which we will cover. 
 
PivotTables work best if you have well-structured data that are organized in continuous rows and 
columns. An example is shown on the SalesData Tab in the spreadsheet you downloaded. Notice that 
there are no blank rows or columns in the data. Having your data structured this way makes creating 
PivotTables easier. 
 

21. To create the PivotTable, select any cell within the table of data you want to summarize. Excel 
can usually tell the data you want to use as the basis for the PivotTable, but if the correct data are 
not selected, you can change the selection later.  
 

22. Select Insert and then “PivotTable from the top Menu bar 
 

 
 

Figure E-16 – Selecting the Pivot Table option from the Insert menu 
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23. This brings up the dialog box shown in Figure E-17. Be sure to check the Table/Range selection. 
If the wrong range is selected, correct it now to match the Figure E-17.  
 

 
 
Figure E-17 – Create Pivot Table Initial Options 
 

24. Generally, you should place the PivotTable in a new worksheet. Clicking on OK creates a new 
worksheet that contains a PivotTable Form and Field List. Its name should be Sheet3 

 
25. Figure E-18 shows a PivotTable Form and Field List. The Field List shows the column headings 

from the data range of your data source. In this case, we have four fields: Sales Rep, Quarter, 
Category, and Amount. The form provides areas into which you can drag elements of the 
PivotTable (see the right columns of your new sheet). These correspond to the four areas shown 
at the bottom of the Field List. 

 
 
Figure E-18 – Create Pivot Form and Field Initial Screen 
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26. Let’s start by creating a very simple PivotTable that shows the total sales amount for the period 
covered by the original data. To create this report, simply click the checkmark next to “Amount” in 
the PivotTable Fields section. This simple operation allows you to quickly calculate the sum of the 
amount values in the underlying data. Look on the right side of your spreadsheet and you will see 
the available PivotTable Fields as shown in Figure E-19.  Figure E-20 demonstrates the totaling 
of the Amount Column (i.e. the Pivot Table), which appears on the left side of your sheet. 

 

 
 

Figure E-19 – Selecting fields to summarize or display 
 

 
 

 
 

Figure E-20 – First Simple Pivot Table! 
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27. Now let’s make a more complex PivotTable. Suppose that you are the sales manager in charge 
of these sales representatives. You might want to see the sales broken down by sales rep. To 
create this PivotTable, simply Slide the  “Sales Rep” (field) from the Field List and drop it on the  
“Rows” area (slightly below it) (Figure E-21), which creates the PivotTable results shown in Figure 
E.22. 

 

 
 

Figure E-21 – Demonstration of clicking on SalesRep and dropping on Rows in the Pivot 
Table Options.  

 
 

 
 

Figure E-22 – Pivot Table showing Sales by Sales Rep 
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28. Suppose that you now want to see if the sales rep’s performances vary by quarter. Add this 
dimension by dragging “Quarter” to the “Columns” area. This creates the PivotTable provided in 
Figure E-23. You may wonder why we put “Quarter” in the column labels section rather than row 
labels. This is a judgment call. Normally you want to avoid putting too many different values in the 
column labels section. This lets us reduce the amount of horizontal scrolling necessary to view 
the data. Since there are only four distinct values in the Quarter field, we placed it in the column 
labels. If you do not like a particular arrangement, you can quickly change it to suit your 
preferences. See Figure E-24 which demonstrates sales by quarter by sales rep. 

 
 

 
 

Figure E-23 – Demonstration of placing the “quarter” field in the columns option. 
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29. The PivotTable in Figure E-24 illustrates a key feature of PivotTables, which is the ability to “slice 
and dice” data by multiple dimensions. In this case, we have two dimensions: Sales Rep and 
Quarter. The number of dimensions is limited only by the characteristics of your data (how many 
fields you have) and your computer’s memory. It is unlikely that you will ever exceed these limits. 
 

 
 
Figure E-24 – Sales by Quarter and by Sales Rep. 

 
30. Let’s add one more dimension to our PivotTable by dragging “Category” to the “Rows” area 

so that it is below Sales Rep. The order in which the labels appear in the Field List is important 
since this determines the order in which the values appear in the PivotTable.  
 

31. Figure E-25 shows the PivotTable with the Category dimension added. Notice that there are 
some empty cells in this PivotTable. This indicates that the original data set did not contain any 
values with that particular combination of dimension values. For example, Fred Smith did not sell 
any peripherals in Quarter 2. Also notice that the sales rep names appear to the left of the 
category names. This is because Sales Rep is above Category in the Field List row labels 
section. If Category was on top, the category names would appear to the left of the sales rep 
names. 
 

 

 
 
Figure E-25 – Sales by Quarter, Sales Rep and Category (Product) 
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32. Format the amounts to be zero decimals with , (comma) separators. Your final results are shown 
in Figure E-26. 

 

 
 
Figure E-26 – Final Sheet with formatting. 
 
 
 

33. Rename this Sheet to be Pivot 
 

 
 

Figure E-27 – Rename the Sheet to be Pivot 
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Appendix 1.1  Uploading a file to Entropy that is stored on your machine. 
 
1. Make sure your Excel file is closed. Excel should not be open when you upload it to Entropy. 

 
2. Open a web browser (not in Horizon). 

 
3. Go to Entropy (https://csbapp.uncw.edu/Entropy/). Enter your Entropy UserID and Password and 

select the appropriate class. 
 

4. Click the Upload Assignment option. 

 
 
Figure Appendix-1: Entropy, starting the process to upload an assignment 
 
 

5. Find the correct assignment you wish to upload. Most likely the file will be in one of the following 
folders: Documents, Downloads or OneDrive. This will vary based on your instructor. 

 
6. Click Upload Now beside the appropriate assignment. 

 

 
 
Figure Appendix-2: Entropy, upload an assignment 
 

7. Entropy will respond with a listing of all files uploaded and their date/time. Should you upload a file to 
the same assignment more than once, it will list both uploads but only keep and grade the most 
recent upload. 

 

 
 
Figure Appendix-3: Summary of files uploaded 
 

https://csbapp.uncw.edu/Entropy/

